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Chapter 1

System Generator for DSP Overview

The System Generator for DSP is a design tool in the Vivado® Design Suite that enables you to
use the MathWorks® model-based Simulink® design environment for FPGA design. Previous
experience with Xilinx® FPGAs or RTL design methodologies is not required when using

System Generator. Designs are captured in the Simulink modeling environment using a Xilinx-
specific block set. All of the downstream FPGA implementation steps including RTL synthesis
and Place and Route are automatically performed to produce an FPGA programming bitstream.

Over 80 building blocks are included in a Xilinx-specific DSP block set for Simulink. These
blocks include common building blocks such as adders, multipliers and registers. Also included
are complex DSP building blocks such as forward-error-correction blocks, FFTs, filters and
memories. These blocks leverage Xilinx LogiCORE™ IP to produce optimized results for the
selected target device.
In this tutorial, you will do the following:

e Lab 1: Use Simulink to create a simple design, create a subsystem, and then simulate.

e Lab 2: Build a basic design in System Generator, simulate the design, then generate an
FPGA bitstream for a target Xilinx technology.

e Lab 3: Learn how signal routing blocks are used to re-define or modify fixed-point
numbers at the bit-level.

e Lab 4: Create a finite state machine using the Mcode block in System Generator.

e Lab 5: Change sample rates in a multi-rate DSP design and then convert a serial data
stream to a parallel data word and a parallel data word to a serial data stream.

e Lab 6: Use a Xilinx ROM block to implement a trig or math function such as arcsin.

e Lab 7:Include a System Generator model within a Vivado IDE design and combine that
model with other RTL sources.

e Lab 8: Import C/C++ source files into a System Generator model by leveraging the tool
integration with Vivado High-Level Synthesis (HLS).

e Lab 9:Including a System Generator Design as a Module in an IP Integrator Design

e Lab 10: AXI4-Lite Interface Synthesis
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i‘ XILlNX Software Requirements

Software Requirements

The lab exercises in this tutorial require the installation of MATLAB 2012b (or later) and
Vivado Design Suite 2013.3 (or later).

Hardware Requirements

The supported Operating Systems include Redhat 5.6 Linux 64, Windows 7 and Windows XP
(32 and 64 bit). Xilinx recommends a minimum of 2 GB of RAM when using the Vivado tool.

Configuring MATLAB to the Vivado™ Design Suite

Before you begin, you should verify that MATLAB is configured to the Vivado Design Suite.
Do the following:

1. Select Start > All Programs > Xilinx Design Tools > Vivado 2013.x > System
Generator > System Generator 2013.x MATLAB Configurator

-

2 Select a MATLAB installation for System Generator ‘l.."i'u'ad::-...l. — | (= |ﬂh

Choose MATLAE for System Generator Vivada 2013.1

MATLAB Version Status Location
ik R2012b Mot Configured CHEDANMATLABYR2012b

rerove ) [ty ) (o) o]

2. Click the check box of the version of MATLAB you want to configure and then click OK.

Locating Tutorial Design Files

You can find the design files for this tutorial next to the associated document file on the Web

<www.xilinx.com> > Support > Product Support & Documentation > Design Tools > See
All Vivado Design Suite Documentation > Vivado Design Suite - 2013.x Tutorials
(http://www.xilinx.com/support/documentation/dt vivado.htm)

After downloading the file ug948-design-files.zip, extract the contents to any write-accessible
location on your disk. This tutorial assumes that you are extracting the data files to the C drive.
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i- XILlNX Locating Tutorial Design Files

Note: You will modify the tutorial design data while working through these tutorial exercises.
You should use a new copy of the original ug948-design-files directory each time you start the
exercises.
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i: X"_l NXP Objectives

Lab 1: Using Simulink

In this lab exercise, you will learn the basics of Simulink. You will use a Simulink block set to
generate a simple design and take it through simulation. You will then change the sampling
settings to see its effect on the output. You will then learn how to create a subsystem.

Objectives

After completing this lab, you will be able to:
e Use the Simulink tool to create a simple design
e Create a subsystem and simulate

e Describe the effect of the sampling period

Procedure

This exercise has four primary parts. In Step 1, you are introduced to the Simulink environment.
In Step 2, you will analyze the effect of the sampling period. In Step 3, you will create a simple
filter design using a Simulink block set. Finally, in Step 4, you will create a subsystem of the
design and perform simulation.

Part 1: Introduction to Simulink

In this part you will become familiar with the MATLAB and Simulink environments (software
tools from The MathWorks suite). You will start with a blank worksheet, add a Sine Wave source
element, add a Scope sink element, and wire the two, as shown in the figure below:

#1, untitled * [E=EER =
File Edit View Display Diagram Simulation Analysis Code Tools Help
EE =
-8 & G- 4® b » ()~
Model Browser = untitled
untitled ® |[Pa]untitled hd
@ n T
[ W
EI Sine Wave Scope
—_—
Ready 100% oded5
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Part 1: Introduction to Simulink

Select Start > Programs > Xilinx Design Tools > Vivado > System Generator > System
Generator.

Navigate to the labl folder: cd C:/ug948-design-files/labl

You can view the directory contents in the MATLAB Current Directory window, or type (s
at the command line prompt. Many UNIX-type shell commands work from the MATLAB
command window.

1. Type simulink at the MATLAB command prompt or click the Simulink button in the
MATLAB toolbar to open the Simulink Library Browser.

Analyze Code D | .
Lsf () = {0} Preferences
é? Run and Time

Simulink  Layout "5l Set Path
L,:é’ Clear Commands = Library -

CODE SIMULIN ENVIRCNMENT

2. Examine the available blocks in the Simulink Library Browser

The following elements, among others, should appear:

. Simulink (sources and sinks)
. Xilinx Blockset
. Xilinx Reference Blockset
Model-Based DSP Design using System Generatorwww.xilinx.com 10
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i. X"—I NX? Part 1: Introduction to Simulink

-
P9 Simulink Library Browser Elﬂlg

File Edit View Help

P 3 » Enter search term + 4 @

Libraries Library: Simulink/Sources {4 %P [

=-[*a] simulin -
- Commonty Used Blocks {{l\[ L B

-+ Continuous

- Digcontinuities

- Discrete

-~ Logic and Bit Operations

-~ Lookup Tables

-~ Math Operations /Wh X L&

- Model Verification

- ModelWide Utilities

-~ Ports & Subsystems

- Signal Attributes

-~ Zignal Routing

- SOUrCes

- User-Defined Functions

[+ Additional Math & Dizcrete

EEI-- Communications System Too...

EEI-- Computer Vigion System To...

Control System Toolbox 1 b

+-[*a] DSP System Toolbox

Image Acguisition Toolbox Constant

Report Generator
- [%a] Simulink 3D Animation

- [Pa] Simulink Coder I{m X
-[*a Simulink Extras

Stateflow Counter Free-
- [P Xilinx Blockset Running

Xilinz Reference Blockset
||"H J.l]l S

Band-Limited
White Moise

m

Chirp Signal

Clodk

Showing: Simulink/Sources
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Part 1: Introduction to Simulink

3. As shown below, right-click on any block in the Library Browser and select Help from the
MATLAB menu

# “
#1 Simulink Library Browser = | B
File Edit View Help
7l | 3| Enter search term - ﬂ Gy
Libraries. Library: Simulink/Sinks Ses
=-[Pa] simutink -
- Commonly Used Blocks ,IE'
- Continuous
D.lscuntmumes Disp| Add to a new model Ctrl+1
- Discrete -
-Logic and Bit Operations Help for the Display block
- Lookup Tables Go to parent
-~ Math Operations |:
- Model Werification Block parameters
- Model-Wide Utilities ———— =T
- Ports & Subsystems cating scops || r

This provides details about the block. You can also select Help from the Xilinx Blockset
elements.

4. As shown below, click the New model button in the Simulink Library Browser to create a
new model blank sheet. The name of the new model worksheet is “untitled” by default.
Later you will change the name of the model.

'DiSimul'lnk Library Browser =B -
File Edit View Help

) | »  Enter search term
Libral

Mew model

ML

Library: Simulink/Sinks

—]

5. Inthe Library Browser window, expand the Simulink Library and click Sources

-~ Commonly Used Blocks
-~ Continuous

Pl i i

6. Scroll through the library to find the Sine Wave source. Select and drag Sine Wave onto
the worksheet.

7. From the Simulink Browser, select Simulink > Sinks, add the Scope block, and draw a
wire from the Sine Wave to the Scope block. An automatic block connection tip
appears.

Note: To draw a wire, move the cursor to the source output port (the cursor will become
a cross-hair). Click and drag your mouse to an input port of destination.
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!. X"—lev Part 1: Introduction to Simulink

- .
L untitled * [ =H{C] &J
File Edit View Display Diagram Simulation Analysis Code Tools Help
]| = (el
E-8 & e -E 40P » @ -
Model Browser = untitled
untitled & untitled v
@ n =
El Sine Wave Scope
=
Ready 100% oded5
h

Next, you will assign a 2*pi*(1/150) frequency to the Sine Wave element and show port
data types. You will change the stop time of the simulation to 150 and set the Solver

options.
1. Double-click the Sine Wave block.
The Block Parameters dialog box opens.

2. Change the frequency to 2*pi*(1/150), as shown below and then click OK to close the
dialog box.

Freguency:
2*pi*(1/150)

3. On the worksheet, select Display > Signal & Ports > Port Data Types

The signal type is displayed above the wire, as shown below:

L untitled * = | B S
File Edit View Display Diagram Simulation Analysis Code Tools Help
]| = (ol
-8 e Cie A= CN 1 » @~
Model Browser == | untitled
untitled ® untitled v
Q P =
IE' Sine Wave Scope
=
Ready 100% oded5

4. From the project sheet, select Simulation > Model Configuration Parameters.

5. From the Configuration Parameters dialog box, enter 150.0 in the Stop time field, and
make the following selections in the Solver and Task mode options:

Type: Fixed-step
Solver: discrete (no continuous states)

Tasking mode for periodic sample times: SingleTasking
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Part 1: Introduction to Simulink

Setting these parameters allows your simulation to run for 150 time units.

\5::,: Configuration Parameters: untitled/Configuration (Active)

S5

Select: Simulation time
i Solver

Data Import/Export
+- Optimization
+-Diagnostics

Start time: 150.0 Stop time: 10.0

Solver options

»

E-"Hardware Implementation | Type: [Fixed—step -] Solver: [discrete (no continuous states) ~

E"'Mnde\ Referencing
+-Simulation Target Fixed-step size (fundamental sample time): auto

Tasking and sample time options

Periodic sample time constraint: [Unconstramed

Tasking mode for periodic sample times: [SmgleTasking

[Z] Automatically handle rate transition for data transfer

[7] Higher priority value indicates higher task priority

6. Click OK
Next, you will parameterize the Scope block.
1. Double-click the Scope block.

2. Click the Scope Parameters button.

ruchpe l‘:' = ﬂh1

sola~i@RA B -

Time offset: 0
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i. X"—l Nxv Part 1: Introduction to Simulink

3. In the Scope Parameters dialog box, set the Time range to 150 and then click OK.

—_ L=

.
H ‘Scope’ parameters

General | Higtory

Axes

Mumber of axes: [4 [ fleating scope

Time range: [150

Tick labels: | bottom axis onty -

Sampling

Decimation - | 1

| Ok | | Cancel| | Help | | Apphy

b

Next, you will run the simulation.
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Part 1: Introduction to Simulink

1. From your Simulink project worksheet, select Simulation > Run or click the Run

simulation button.

-

bi untitled * = B
File Edit View Display Diagram Simulation Analysis Code Tools Help
-EH S @2 4P » @ ~
Model Browser = untitled m

| - R |

2. On the Scope display, click the Autoscale button so that the output will fit into the

Scope
(B score e
EE B ER N FEEIEE R

K

Time offset. 0

3. View the Scope output

A smooth sine wave should fit into your scope window, which is what you would expect
because you are running a double-precision software simulation.
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!. X"—l NX? Part 2: Analyzing the Sampling Period Effect

Part 2: Analyzing the Sampling Period Effect

Now you will run the simulation at a slower sampling period (sample period of 5) of the sine
wave source and analyze the sampling period effect. You will then change the stop time to 500,
run the simulation, and observe the output. Finally, you will change the stop time back to 150.

1. Double-click the Sine Wave block to open its parameter dialog box.

2. Change the Sample time of the Sine Wave source to 5, click OK, and run the
simulation.

Note: As the Sample time is increased (i.e. fewer inputs are sampled), the quantization
error is increased.

rn Scope l':' 5] ﬁr

B0 i NS Eas -

3. Type 500 in the worksheet toolbar window and press Enter to change the simulation
stop time.

“

AR X

m  Simulaticn  Analysis  Code  Tools  Help

a0 © -2 ‘%'@ﬂb (&) ~ sobo Nomal — ~| (@~

4. Run the simulation and observe the output in the scope window.

You may have to click the Autoscale button in the Scope block GUI to see three
complete Sine wave cycles.

5. Change the simulation stop time back to 150.

6. Change the Sample time of the Sine Wave source back from 5 to 0 and click OK.
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!‘ X"—l NX’ Part 3: Creating a Simple Filter Design Using Simulink Blocks

Part 3: Creating a Simple Filter Design Using Simulink
Blocks

In this part, you will build a simple design to implement the following function by using the
appropriate blocks from the Simulink block set: Y(n+1) = X(n+1) + 3 * X(n-1).

1.

7.

Model-Based DSP Design using System Generatorwww.xilinx.com

From the Simulink Library Browser, select the Discrete library. Select and add the Delay
block to the design.

Double-click the Delay block and verify the Delay length set to 2.

From the Simulink Library Browser, select the Math Operations library. Select and add the
Gain block to the design.

Double-click the Gain block and change the Gain to 3.

From the Simulink Library Browser, select the Math Operations library. Select and add the
Add block to the design.

Connect the blocks as shown below:

f\ double
+ double

Sine Wave

3

A 4
+

Add Scope

double

p 72

Integer Delay Gain

Run the simulation and observe the output.

uSccrpe l':'@ih,l
SEHPLL ABRB BPASF -

Time offzet. 0O
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& XILINX.

Part 4: Creating a Subsystem

Part 4: Creating a Subsystem

In this part you will select all the blocks between the source and sink, and then create a
subsystem. You will name the subsystem “Filter”, run the simulation and verify that the output is
still the same. You will then save the model as labl.slx in the current working directory and

then Exit MATLAB.

1. Click in a white space and create a rectangle enclosing all relevant blocks and

connections to select all the blocks between the source and sink

' Y
B3, untitled * EESEEN
File Edit View Display Diagram Simulation Analysis Code Tools  Help
-8 & @2 40P @~ 100  [Memd ] @~
Model Browser *= | untitled
untitled ® untitled
Q‘ L{'\ double o
L double l:l
[ RY, « —» |
Sine Wave (|
- Add Scope
= double double
z —b-
|. Deimy -
«
Ready 100% Fixed5StepDiscrete

2. Select Diagram > Subsystem & Model Reference > Create Subsystem from
Selection or press Ctrl+G

- ™
P2 untitled * [E=SREER S
File Edit View Display [ Diagram ] Simulation  Analysis Code  Tools  Help
E: - o Refresh Blocks Ctrl+K i @ - [on e .
Subsystem & Madel Reference w Create Subsystem from Selection Ctrl+G L
Model Browser v unti Format N Convert Subsystern to 3
untitled ] _ r
Rotate & Flip 4 Model Block Nermal Mode Visibility... =
Q. Arrange b Refresh Selected Model Block
N —_—— |doutle |
[ Mask » I I:II
- Library Link 4 Add Scope
Signals & Ports s Pw
Block Parameters Gain
« Properties...
Ready 100% FiedStepDiscrete
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i: XIL'NXs Summary

3. Name the subsystem Filter by selecting and typing over the title

r .
9& untitled * [ =RHACY éj
File Edit View Display Diagram Simulation Analysis Code Tools Help
-8 a e -EH 4P = @ w0 fom -] @-
Model Browser = untitled
> [Pa] untitled ® |[Pa|untitled M
@l: double
a [ —
Sine Wave:
double =1
= | in1 0wt [ e
|
[Subsyst=m
«
Ready 100% FixedStepDiscrete
. b
Filter

You can adjust block placements so that the design appears lined up. The design should
look similar to the figure below:

i -
'Di untitled * [ = | [ ﬂ_hj
File Edit View Display Diagram Simulation Analysis Code Tools Help
HE — ik .
@'é im@' G > 0> (&) ~ 1500 » (4 ~
Model Browser *= | untitled
b [*a] untitled @ |[Pa]untitled » M
[ Jeoubie it outs B T
IE' | U | N L
Sine Wave Scope
=+ Filter
=
Ready 100% FixedStepDiscrete

4. Click File > Save and enter lab1.slx as the filename.

5. Click Save to save the file in the current directory. You will notice that the worksheet
name at the top-left corner changes from untitled to lab1.

6. Type exit in the MATLAB command window to close MATLAB.

Summary

In this lab, you learned the basic design flow involved in Simulink using the Simulink block set.
You observed the effect of a sampling period. You simulated the design using the Simulink
simulator and observed the output using the Scope block. Finally, you created a subsystem.
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i: X"_l NX Objectives

Lab 2: Design Creation Basics

This lab exercise will introduce you to the basic concepts of creating a design using System
Generator for DSP within the model-based design flow provided through Simulink. The design is
a simple multiply-add circuit.

Objectives

After completing this lab, you will be able to:
» Simulate a design in System Generator for DSP
* Run the System Generator token to generate a Xilinx FPGA bitstream
* Create a subsystem

« Improve performance using dedicated Xilinx FPGA math functions

Procedure

This lab has four primary parts. In part 1, you open and simulate a Simulink block set-based

design that serves as an "executable specification”. In Part 2, you re-create the Simulink design
using the Xilinx block set. In Part 3, you take the Xilinx executable specification through the full
implementation flow. Finally, in Part 4, you explore different hardware architectures to achieve

the best performance.
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!. X"—l NX? Part 1: Simulate the Executable Specification

Part 1: Simulate the Executable Specification

1. Launch the MATLAB program and change the working directory to:
C:/ug948-design-files/lab2

2. Open the file lab2.slx and observe the following design.

1

Random
Mumber

LA i
®
h 4
Y

Product
"\ Add oy

\J

Sine Wawe

4

Constant

Note: This design is an executable specification created in Simulink using the standard
Simulink block set. It is a simple multiply-add circuit but serves to demonstrate many of
the key concepts of model-based design. You are going to design a Xilinx FPGA to this

spec.
3. Simulate the design for 100 cycles by pressing the play button on the toolbar.
View the waveform by double-clicking on the Scope block.

ru Scope l‘:' =] ﬂh1

S RN I R 3
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!. X"—l NXP Part 2: Duplicate the Design using Xilinx Blocks

Part 2: Duplicate the Design using Xilinx Blocks

1. From the Simulink Library Browser, open the Xilinx Blockset Library and the Index sub-
library to access the blocks. Create a Xilinx version of the multiply/add design using
Xilinx blocks. Remember you must use Xilinx Gateway In / Gateway Out blocks to
define the FPGA boundary and you must place a Xilinx System Generator token in the
design, as shown in the figure below. Leave all the block settings at their default values.

V|

Random
Mumber »>
* -
? > N[
Product g
ﬁu Add Scope
Sine Wawe
1 8
Constant
System
Gateway In = 7_"-’
a=h
b
» Mult a

b
Gateway Out g #
" AddSub

Gateway In2

2. Simulate the design and view the waveform on the Scope attached to the Xilinx
implementation. Notice that the waveforms have square edges. This is because the
System Generator block set forces a discrete sampling of the input signals that
represents the behavior of the actual hardware that operates on synchronous clock

edges.

7 5
n Scopel S | B ||

a0
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& XILINX.

Part 2: Duplicate the Design using Xilinx Blocks

3. Compare the results from the executable spec vs. the Xilinx implementation using a
Subtractor from the “Simulink/Math Operations” library as shown below.

This is an important model-based design concept.

i

Random
Number

I

Yy

W

Sine Wave

1

Product

Yy

Constant

Gatewsy In1

In

Gatewsy In2

+n =,

a=h

&

System
Generator

Mult

Y

a+h

-

SN

Gatewsy In3

AddSub

v ]

Y

Subtract Scope

Gatewsay Out

4. Add 3 Unit Delay blocks from the Discrete Library at the output of the Add block as
shown below and re-simulate the design.

_..+
— -+

1

double

double q double
g g

z

z

double
|

M| =

Unit Delay  Unit Delay1

Unit Delay2 ‘

The design is now functionally matching the executable spec. The next part is to perform
the FPGA implementation steps that include RTL generation, RTL synthesis and Place and

Route.
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& XILINX.

Part 3: Implement the Xilinx Design

Part 3: Implement the Xilinx Design

1. Double-click on the System Generator token and set the Compilation target to HDL
Netlist, as shown below. Also, verify that the output device is set to Kintex7 xc7k325t-

2£fg900.

-
u System Generator: lab2

(SR =

& o a

Compilation Clocking General

Compilation :

HDL Netist

Part :

Kintex7 xcTk325t-2ffgB00
Synthesis tool ;

Vivado

Target directory :

JAnetlist

Project type :

Vivado

Synthesis strateqy :

Vivade Synthesis Defaults

|:| Create interface document

Impert az configurable subsystem

Settings ...

Hardware description language :
WHDL

-

Browse...

Implementation strategy :

Vivade Implementation Defaults ~

|:| Create testbench

Model upgrade...

Perfurmanceﬁpsl [Generatel ’

oK I ’ Apply ] ’ Cancel ] [ Help ]

2. Click the Generate button to initiate the netlisting process.

System Generator will automatically execute the HDL netlist generation and display the
following message when finished.

.
#t Compilation status

S

Generation Completed

&
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& XILINX.

Part 3: Implement the Xilinx Design

3. Invoke the Vivado Integrated Design Suite (IDE):
Start > All Programs > Xilinx Design Tools > Vivado 2013.x

4. Click on Open Project and then navigate to the folder C:;/ug948-data-
files/lab2/netlist/hd|_netlist

5. Double-click on the file lab2.xpr and the Vivado IDE will invoke on the generated project
file as sown below:

-
ﬁl} lab2 - [C:/ug948-data-files/lab2/netlist/hdl_netlist/lab2.xpr] - Vivade 2013.1

File Edit Flow Tools Window Layout View Help

PR L L L L P e
Flow Navigator « | Project Manager lab2
@ T == Sources i s

| QA= we RE

|4 Project Manager
ﬁ. Project Settings
Sfj‘ Add Sources
1F 1P catalog

Design Sources (2)

#hi %, lab2 - structural (252, vhd) (2)

wh synth_req_req - behav (synth_req.vhd)
=) Constraints (1)

[-= Simulation Sources (1)

4 [P Integrator
.ﬁ:"; Create Block Design

¥ Open Block Design H

IF Sources |Libraries |Con1|:|ile Order |

4 Simulation 44 Sources L ¢ Templates J |
&% smulation Settngs || _ 777

@. Properties
Run Simulation ]
« SEx
4 RTL Analysis
> &% Open Elaborated Design

— 0O 2» =

4 Synthesis
ﬁ Synthesis Settings
$- Run Synthesis
> @ Open Synthesized Design Design Runs

Name Part

== synth_1 xcTk3I25tfC
e impl_1 xcTk325t T

4 Implementation
ﬁ. Implementation Settings
[» Run Implementation
» ﬁﬁ’ Open Implemented Design

4 Program and Debug

ﬁ. Bitstream Settings

;Q Generate Bitstrj};n

H Open Hardware Segeinn
Generate Bitstream

Generate a programming file aﬁer |mp|ementﬂt|2ﬂ. 4| 2 repor

Generate a programming file after implementation.
R ——

B Launch mpacT
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i- X"—lNX Part 4: Explore Different Hardware Architectures

6. The following message dialog box will appear.

i N
Mo Implementation Results Available @

k' There are no implementation results available. Okay to launch synthesis and implementation?
Y 'Generate Bitstream' will automatically start when synthesis and implementation completes.

[ Don't show this dialog agairé

[ H‘ES&[ No |

7. Click Yes to start the synthesis and implementation process.

Note: If this dialog box does not pop up, then you should click on Run Implementation
manually and let the Synthesis and Implementation processes complete.

You now have an initial implementation
8. Close the lab2.xpr project

The remainder of this lab will focus on some common techniques used to explore different
hardware architectures.

Part 4: Explore Different Hardware Architectures

1. Select all the Xilinx components, including the System Generator token and push them
into a subsystem by pressing Ctrl-G. The diagram should look like the following figure:

Eﬂ double

Random
Murnber double
X » + double | 1 Jdoubld 1 |doubld 1 Jdouble

L L L

|'n‘. double Product — z z z
U nit Drelay Unit Delay1  Unit Delay2

Sine Wave

double

1 =+ double |:|

Constant Subiract Scope

M Ini

double

 n2Outi

] In2

Subsystem
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i- X"—lNX Part 4: Explore Different Hardware Architectures

2. Copy the subsystem to create a second subsystem and connect it to the design as shown
in the figure below:

H]

Random
Number »
x '—b +
1 1 1
ll,—\ Product z = z
| “V'r Add Unit Delay Unit Delay1  Unit Delay2

Sine Wave

]

—+
Constant T
Subtract
o In1
| In2Cut ]
= In3
Scope
Subsystem
L Int Lels
P In2 Out1 -
» In2 Subtract1

Subsystem

You now have a Simulink diagram that contains two subsystems each with a System
Generator token. This represents two FPGAs or two blocks of a single FPGA within a
larger DSP system. Each System Generator token creates a top-level entity from the
subsystem from which it is associated. It will not merge with the other subsystem.
Creating subsystems can be a useful technique when exploring hardware architectures
for a given design.

3. Push into the copy of the subsystem and modify the design to implement the same
function using the Xilinx DSP48 Macro 3.0 block. Select and delete the Mult and AddSub
block. Right-click, select Xilinx BlockAdd and type dsp in the Add block field. Double-
click on the DSP48 Macro 3.0 block and position the block as shown below.

X

.
doublk III Foc 16_14 Generator
a
Gateway In
In2 Fix 16 14 Fix 48 28 doube
Gateway Inl Gatewsy Out Cut1
Foc 45 28
doube Gateway In2

D5P48 Maoro 3.0
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i. X"—l Nxv Part 4: Explore Different Hardware Architectures

Using this block allows improved control over the hardware implementation. The DSP48
macro will force the use of the DSP48 primitives in the final netlist. Port c on the DSP 48
Macro 3.0 block requires an input quantization of Fix_48_28.

Double-click on the Gateway In2 block, set the Number of bits to 48 and the Binary
point to 28, and then click OK.

To view the port quantization values as shown above, execute the following pulldown
menus: Display > Signals & Ports > Port Data Types

Double-click on the DSP48 3.0 Macro block to bring up the properties dialog box editor.
From the Instructions tab, verify the equation to be A*B+C, as shown below. Observe
the other implementation options but leave them at their default values.

3¢ DSP48 Macro 30 (Xilinx DSP48 Macro 3.0 ) s

Instructions | Pipeline Options | Implementation |

Valid operands: COMCAT, P, C, PCIN, P> >17, PCIN=>>17, CARRYIN, CARRYCASCIM, ACIM,
A, BCIN,B

valid operators: +, -, =
Valid functions: RMDSIMPLE, RMNDSYM

Instructions are case insensitive and tolerate spaces.

Target XtremeD5P Slice: DSP43E1

Instryctions Available Instructions

b=B+C # -
(a+0) L
(A+0)*E
(B+D)*B+C
(A +D)*B +C+CARRYIN
(A +D)*B +CARRYIN
(A+D)*B+F
(A +0)*B +P +CARRYIN
(A+D)*B+P==17
(A+D)*B+P == 17+CARR
YIN
(A +D)*B+PCIN
(A +0)*B +PCIN-+HCARRYI
M i

[] Show Filtered Instructions

ok || cancel || Hep || aply
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& XILINX.

Solution

7. Click on the Pipeline Options tab and set the Pipeline Options to Expert, as shown

below.

-

-
3¢ DSP48 Macro 30 (Xilinx DSP48 Macro 3.0) o] -
Instructions Pipeline Options Implementation
N Pipeline options
COMNCAT > >
C — > »
CARRYIN L >
CONTROL e e > > -
4| — — | l_ 3
Tier 1 Tier 2 Tier 3 Tier 4 Tier 5 Tier &
__//T D \~~
A Cla A A
B Cle Cle Cls M
COMCAT COMCAT COMCAT
c Cc Cc Cc c P
CARRYIN CAREYIMN CAREYIM CAREYIMN CARRYIMN
I~ CONTROL CONMTROL COMNTROL COMNTROL COMNTROL L
[ 0K ] [ Cancel l [ Help l [ Apply l

s ———

As shown above, click the A, B, and C boxes in Tier 1, M and C boxes in Tier 5, and the P

box in Tier 6. Un-click all other boxes, then

click OK.

8. Re-simulate the design to insure functional correctness

9. Double-click on the System Generator token to re-generate the HDL Netlist. After the
netlist generation completes, save the lab2.slx design model and exit from MATLAB.

NOTE: If you get an error, it usually means that you forgot to close the lab2.xpr

project file at the end of the previous major Part..

Solution

The complete solution to this lab is in the following location:

C:/ug948-design-files/lab2/solution
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i: X"_l NX Objectives

Lab 3: Signal Routing

This lab exercise introduces you to the System Generator features that you will use to convert
fixed-point numbers from floating-point, re-define the fixed-point format, as well as perform bit
slice, pad and unpad operations. You will also design and verify the padding and unpadding
logic using the System Generator signal routing blocks.

Objectives

After completing this lab, you will be able to:

* Understand how signal routing blocks can be used to redefine or modify a fixed-point
number at the bit level

» Convert a fixed-point number into a new fixed-point number
» Slice bits from a fixed-point number

» Pad and Unpad a fixed-point number

Part 1: Designing Padding Logic

1. Launch the MATLAB program and change the working directory to:
C:/ug948-design-files/lab3

2. Launch the Simulink library browser by clicking on the Simulink icon on the MATLAB
toolbar
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i‘ XILlNX Part 1: Designing Padding Logic

3. As shown below, click the New model button in the Simulink Library Browser to
create a new model blank sheet.

%Simulink Library Browser = | B |-
File Edit View Help

M (T »|  Enter search term - % &
Libra Library: Simulink/Sinks Se:
Mew model

Commonty Used Blocks
- Continuous

L o R ST T

4. Create the design shown below. Use a Constant block from the Simulink “sources” block
set and a Display block from the Simulink “sinks” block set. Set the value of the constant
to .5. Add a Xilinx Gateway In block quantized to fixed_8_6 (signed 2's comp). Also add
a Xilinx Gateway Out block. Connect the blocks already added in the design model as
shown below. Remember that a System Generator token is also required in this
diagram.

To display the signal type Fix_8_6 as shown below, select the work sheet menu item
Format > Port/Signal Displays > Port Data Types, and then run a simulation.

double Fic 8 & double 05

Gat I Gateway Out o
— bew gy In atEway D play

Sy
=

ST

stem
Generator

The objective of this lab is to convert the binary representation of the number .5 when
quantized to fixed [8 6] to the number .007813 when quantized to ufixed [12 12]

fixed [8 6]
[0]o[1]o]o]ofo]0]
Sign Bit o
Integer Bit Fractional Bits

ufixed [12 12]
[ojofofofofoj1]ofofojo]0]

Fractional Eﬁis
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i- X"_lNX Part 2: Designing Unpadding Logic

To accomplish this you are going to have to zero pad the MSBs and reinterpret the
number. This will require the use of the Concat and Reinterpret blocks. Review the Help
text for these blocks to gain a greater understanding of how they work.

5. Now modify the block diagram previously shown to convert the input constant value of
.5 to an output value of .007813. You will first need to use the Reinterpret block to
convert the number to ufix [8 0]. You then use a Constant and Concat block to convert
to ufix [12 0], and then use another Reinterpret block to convert ufix [12 12].

The solution to this exercise can be found in the following location:
C:/ug948-design-files/lab3/solution/lab3_padding_solution.sIx

Part 2: Designing Unpadding Logic

1. You are going to perform an exercise similar to Part 1, but in the other direction. Here
the input will be the constant .007813 and you want the output to be converted to .5
through bit manipulation, not arithmetic.

2. Create the design shown in below. The input constant should be set to .007813 and the
input gateway can be set to fix [12 12]. Remember to include the System Generator
token in the diagram.

double Frg 12 12 double

Gatewsay In Gateway Out Display

System

Constant

Generator

Use the Slice and Reinterpret blocks to manipulate the binary number to achieve an
output of .5. First, you need to use the Slice block to convert the number to ufix [8 0],
then use the Reinterpret block to get fix [8 6]. Refer to the binary diagrams in Part 1 of
this lab.

The solution to this exercise can be found in the following location:
C:/ug948-design-files/lab3/solution/lab3_unpadding_solution.slx
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i- X"—lNX Part 3: Reinterpret vs. Convert Block

Part 3: Reinterpret vs. Convert Block

In this part, you will explore the differences in the effects of using the Reinterpret block vs.
the Convert block

1. Open a new Simulink design sheet by clicking on the New Model icon from the Simulink
Library toolbar.

2. Create the design shown below. Set the input constant to .5, set the parameters of both
the Convert and Reinterpret blocks as shown in the diagram below.

n

double Fic 8 0 Fic 8_0 double
————*In — > cast ;h- |:|
Gateway In Gateway Out Display

y

Constant Cenvert

Fic & O double

Gateway Out1 Displayl

I} Systemn

Generator

¥

Reinterpret

3. Simulate the design. What are the values of Display and Displayl. Why?

Solution

Solutions to this lab can be found in the following location:
C:/ug948-design-files/lab3/solution
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i: X"_l NX Objectives

Lab 4: System Control

In this lab exercise you will be creating a simple finite state machine (FSM) using the MCode
block to detect a sequence of binary values 1011. The FSM needs to be able to detect multiple
transmissions as well, such as 10111011.

Objectives

After completing this lab, you will be able to create a finite state machine using the Mcode block
in System Generator

Procedure

1. Launch the MATLAB program and change the working directory to:
C:/ug948-design-files/lab4

2. Open the file lab4.slx. You will see the following uncompleted diagram.

I
System v
Genarator
e e T R
| ; »-----»[_out]
Repesting Input Found1
Sequence Culput of Block Ram
Stair State Machine

3. Add an MCode block from the Xilinx Blockset/ Index library. Do not wire up the block yet
- first you will edit the MATLAB function to create the correct ports and function name.
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& XILINX.

Procedure

4. Double-click on the MCode block and as shown below, click on the Edit M-file... option.

ESNEERT)

Pass input values to a MATLAB function for evaluation in Xilinx fixed-
point type. The input perts of the block are input arguments of the
function, The output ports of the block are output arguments of the
function.

-
¥ MCode (Xilinx MCode Elock)

Basic | Interface Advanced | Implementation

Block Interface
MATLAB function

Browse... Edit M-File...

Explicit Sample Period

wimax

[ spedify explicit sample period

1

5. Edit the default MATLAB function to include the function name “state_machine” and the
input din and output matched. The sample M-code can now be deleted.

-
" Editor - C\ug945-data-files\labd\state_machine.m

PUB...

= = — - *  Time  Advance

| | | BREAKPOINTS | RUN

D é? @ Lg] Run Section

FILE EDIT MAVIGATE | Bregkpoints Run Runand Runand I%Advm

[state_machine.m X]

1 function matched = state machine (din)
2

| state machine [Ln 2

6. Once the edits have been made, save the MATLAB file as state_machine.m to the lab4

folder and use the Browse button to make sure that the MCode block is referencing the

local MCode file.
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i: XIL'NX Procedure

7. Click OK on the MCode Dialog Box. You will see the MCode block assume the new ports
and function name. Now connect the MCode block to the diagram as shown below

&

h 4

Systemn

Generator

T W |WT_.E|_>M state_machine matchedl — »[ out|—»

Repeating Input matched

Sequence pyv— Output of Blook Ram

Stair

You are now ready to start coding the state machine. The bubble diagram for this state
machine is shown below. This FSM will have 5 states and will be capable of detecting two
sequences in succession.

Din=1

Matched=0
@ Din=1

Din=1
Matched=1
Mztched =0
Din=0
Din=1
Din=0
Din=0
Din=1
Matched=0
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i: X"_l pr Solution

8.

10.

Edit the MCode file, state_machine.m, and define the state variable using the Xilinx
xl_state data type as shown below. This requires that the variable be declared as a
persistent variable. The xI_state function requires two arguments, the initial condition
and a fixed-point declaration. Since you need to count up to 4, you will need 3 bits.

persistent state, state = xl_state(0,{xlUnsigned, 3, 0});

Use a switch-case statement to define the FSM states shown. A small sample is provided
below to get you started. Note that you will need an otherwise statement as your last

case.

switch state
case O
if din == 1
state = 1;
else
state = 0O;
end
matched = 0;

Save the MCode file and run the simulation. The waveform should look like the
following. You should notice two detections of the sequence.

-
B Figures - Output of Block Ram State Machine E@g

=S W d %% *"BODE 0~ »x

Input

Output of Block Ram State Mac...

Solution

The complete solution to this lab is in the following location:
C:/ug948-design-files/lab4/solution
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i: X"_l NX Objectives

Lab 5: Multi-Rate Systems

In this lab exercise you will explore the effects of the rate changing blocks available in
System Generator including the Up Sample, Down Sample, Serial to Parallel and Parallel
to Serial blocks. Upsampling is the process of increasing the sampling rate of a signal and
Downsampling is the process of decreasing the sampling rate of a signal. It is common
practice in signal processing systems to change the sample rate of a signal to simplify the
hardware or processing tasks.

Objectives

After completing this lab, you will be able to:
* Change the sample rates in a DSP System
» Convert a serial stream of data to a parallel word

» Convert a parallel word of data into a serial stream

Part 1: Changing Sample Rate

1. Launch the MATLAB program and change the working directory to:
C:/ug948-design-files/lab5

2. Open a new Simulink model and save it as lab5.sIx in the current working directory.
Create the simple diagram shown below. Use the Counter Limited block from the
Simulink/Sources library and set the upper limit of the counter to 10. Set the
quantization of the Gateway In block to fix [8 0].

Iir_nrlJ-L_l_rl i III Foe 8.0 - double I:l

Counter Limited Gateway In Gateway Out e
Systern
Generator
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& XILINX.

Part 1: Changing Sample Rate

3. Simulate the counter for 10 simulation cycles and observe the results.

rn Scope I.‘:' (=] &r
8o a<«RH%% | 0aF

Time offset: 0

4. As shown below, add a Down Sample block from the Xilinx Blockset/Index library

between the Gateway In and Gateway Out blocks, then re-simulate the design.
What do you observe?

IIFZJJ'LI_I_F| winth Foe B 0 -1 Foe B 0 double
L z L
T e I T
12
Coirie Gateway In Gateway Out S
Lirmited Down Sample
System
Gener ator

5. Replace the Down Sample block with an Up Sample block and re-simulate the design

The System Generator token is going to generate an error that indicates your sample
rate is incorrect.
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i- X"—lNX Part 2: Using Serial-to-Parallel Blocks

6. Double-click on the System Generator token and change the Simulink System Period
to ¥2 as the message suggests. Re-simulate the design. Add Sample Time probes from
the Xilinx Blockset/Index library before and after the Up Sample block and connect the
outputs of the probes to Gateway Out blocks and the Display block from the
Simulink/Sinks as shown in the figure below. These probes do not add any hardware to
the design, but offer a powerful debugging tool for complex multi-rate systems. Re-
simulate the design to observe the sample rate in the Display sinks.

UFee 2 0 double
»| 5T o om N
Sample Time Gateway Out1 Display
UFo 1_0 doubig
ooy
Sample Time1 Gatewsy Out2 Display
Tim wint® Fic 8 0 Fic & 0 double
gl | i SR N e N[
Counter Limited Gatewsy In Gateway Out e

Up Sample

System

Gensrator

In the next two parts, you will explore the rate changing effects of using the Serial to
Parallel and Parallel to Serial blocks from the Xilinx Blockset.

Part 2: Using Serial-to-Parallel Blocks

1. Open a new blank model, and then create the design shown below.

Syst=m

Genarator

Iim_,—'_'—|_|—'_'—| win e :M» UFce 8 O double

Gateway In Gateway Out >

Counter
Limited Serialto Parsllel Scope

2. Set the Upper limit on the Counter Limited block to 1. This is simply going to generate
the sequence 1010101010.
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& XILINX.

Part 2: Using Serial-to-Parallel Blocks

3. Set the output of the Serial to Parallel block to Unsigned [8 0].

52 Serial to Parallel (¥ilinx Serial to Parallel c.. e B 3

Groups of samples presented serially at the input become single
samples presented at the output.

Basic Implementation

Input order:

Latency 1

(@) Least significant word first () Most significant word first
Cutput Precision
Arithmetic type:
) Signed (2's comp) @ Unsigned
Mumber of bits 8

Binary point 1]

Optional Parts

[T Provide reset port

[7] Provide enzble port

[

K ] [ Cancel ] [ Help ] ’ Apply l

e ————

The Serial to Parallel block will impose a rate change on the system equal to the
number of output bits / number of input bits. In this example, you have 8 output bits and
2 input bits so the rate change will be set to 4.

4. Click OK on the block dialog box, and then add sample rate probes to the input and
output of the Serial to Parallel block. Re-simulate the design and observe the sample
rates.

Input Sample Rate
Output Sample Rate

5. Change the output quantization of the Serial to Parallel block to fix [16 0] and re-
simulate. What are the sample rates now?
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i- X"—lNX Part 3: Using Parallel-to-Serial Blocks

Part 3: Using Parallel-to-Serial Blocks

1. Replace the Serial to Parallel block with the Parallel to Serial block. Leave the output
quantization at the default ufix [1 0].

2. Change the sample rate in the System Generator token from 1 to ¥z, then click OK.
3. Re-simulate the design and record the input and output sample rates.

Input Sample Rate

Output Sample Rate

Note: You may get an error with the Sample Time (ST) probe connected to the
output. If this occurs, just temporarily connect the probe to the input signal,
perform the simulation once, then reconnect the probe to the output signal again
and re-simulate.

Solution

The complete solution to this lab is in the following location:

C:/ug948-design-files/lab5/solution
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i: X"_l NX Objectives

Lab 6: Using Memories

In this lab exercise you will learn how to use a Xilinx ROM block to implement a LUT-based
operation such as an arcsin using block or distributed RAM. This provides an efficient
implementation for trig and math functions with inputs that can be quantized to 10 bits or less.

Objectives

After completing this lab, you will be able to use a Xilinx ROM block to implement a trig or
math function such as arcsin.

Procedure

1. Launch the MATLAB program and change the working directory to:
C:/ug948-design-files/lab6

2. As shown below, open the Simulink executable spec named lab6.sIx. Double-click on the
Lookup Table block to see how the arcsine function has been defined.

From
Lockup Table
Workspace F ¥ Graph

[1:201;-1:.01:1)
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i: XIL'NX Procedure

3. Simulate the counter for 201 simulation cycles and observe the results. The design is
using the Simulink XY Graph to plot the output data as a function of the input data.

Bl ¥ Graph = | B
XY Plot

2

151
1t
05}
ot

Y Axis

05
At

-1.5

-1 -0.5 0 0.5 1
X Axis

b

Note: This plot is a Simulink representation of the MATLAB arcsine example that is
displayed when you type doc asin from the MATLAB command line prompt.

X = -1:.01:1;
plot(x,asin(x)), grid on

4. Add a Xilinx Gateway In, Gateway Out, System Generator token and ROM block as
shown in the figure below.

10

[1:201:-1:.01:1] .":-/ »
From
Works pace Lockup Table W Graph
System
Gener ator O
Gateway In Gateway Out
I} RO 0 Graphi
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i: XIL'NX Procedure

5. Double-click on the ROM block and set the initialization vector equal to asin([-1:.01:1])
and the depth to 256. This is the same initialization as the Simulink Lookup Table block.
The Xilinx memory blocks are going to require depths to fall on power of 2 boundaries.
The MATLAB statement used to initialize the ROM is only going to set 201 locations. The
other locations will be uninitialized.

6. Simulate the design for 201 clock cycles. You are going to get an error indicating an
incorrect quantization at the input of the ROM block. You left the quantization of the
Gateway In block to the default value of fixed [16 14]. To address a Xilinx memory, the
guantization must be ufix with no fractional bits. Since you have a 256 element address
space, you are going to need an input quantization of ufix [8 0]. Change the gateway
and re-simulate.

View the waveform in XY Graphl. You will notice that it is incorrect.

B ¥ Graphi = | S
XY Plot

2

1581 1
1F 4
051 1

0 . 4

Y Axis

05} -
At -
A5} —

-2 L 1 I
-1 -0.5 0 0.5 1

¥ Axis

The reason the waveform does not match is that the quantization of the Gateway In is
truncating the fractional bits and the sign bit. It is not as simple as just re-specifying the
guantization. The arcsine value for the input “-1" is stored at address location zero and
the arcsine value for 1 is stored in location 201. To match the behavior of the MATLAB
LUT block, which can accept negative and fractional numbers as inputs, you need to
convert the input data to an appropriate RAM address.
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i: XIL'NX Solution

7. Add a second From Workspace block to the diagram and configure the block to
generate outputs from 0 to 201. This is the simplest approach. The “data” field should be
specified as follows:

[1:201;0;1:200]"

[1:201;-1:.01:1] ]

From Lockup Table

Workspace Hf Graph

&

System

s te
Generator O
o

Gateway In Gateway Out

From
Works pacel

ROM X Graph

8. Re-simulate. You should see correct results.

9. Since System Generator doesn’t generate a Bitstream, you need to generate an HDL
Netlist, then open the project file in the Vivado IDE and generate a Bitstream.

Record the results.

Registers
Block RAMs
Slices

10. Double-click on the ROM block and set the Memory Type field to Distributed. Run
System Generator and record the results.

Registers
Block RAMs
Slices

Solution

The complete solution to this lab is in the following location:

C:/ug948-design-files/lab6/solution
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i: XIL'NXP Introduction

Lab 7: Including a System Generator Nodel
in a Vivado IDE Design

Introduction

Typically, a System Design Engineer has to include hardware design sources from a variety of
different formats and put them together into a final system-level design. This lab exercise
provides an overview of how you can include a System Generator model within a Vivado® IDE
design and combine that model with other RTL sources.

Part 1: Create a new Vivado IDE Project and add
RTL/DSP sources and XDC constraints

1. Navigate to the C:/ug948-design-files/lab7 folder and launch the Vivado IDE from this
directory.

2. Select the pull-down menu File > New Project and then click Next

New Project x|

Create a New Vivado Project
This wizard will guide wvou through the creation of a new project
To create a vivado project you will need to provide a name and a location for your project

files. Mext, wou will specify the type of flow wou'll be working with. Finally, wou will specify
wour project sources and choose a default part.

| v\vaDO™

To continue, click Mext,

MNext = | Cancel
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!‘ X"—l NX’ Part 1: Create a new Vivado IDE Project and add RTL/DSP sources and XDC constraints

3. As shown below, specify the project name as vivado_dsp and the project location as
C:/ug948-data-files/lab7/vivado_dsp_source, then click Next

g'” New Project Iz
Project Name
Enter a name for your project and specify a directory where the project data files will be stored ﬁ\i

Project name: | vivado_dsp
Project location: | C: fug948-data-fileslab?vivado_dsp_source E]
Create project subdirectory

Project will be created at: C:/ug945-data-fileslab7 vivado_dsp_sourcevivado_dsp

[ < Back ][ Mext = ] Finish

.

4. Select the RTL Project option, as shown below. Make sure that the option Do not
specify sources at the time is unchecked and then click Next

g‘” Mew Project o
Project Type
Spedfy the type of project to create. ':L/

@ RTL Project
~ You will be able to add sources, generate IF, run RTL analysis, synthesis, implementation, design planning and analysis.

|:| Do not specify sources at this time
, Post-synthesis Project
‘fou will be able to add sources, view device resources, run design analysis, planning and implementation.
Do not spedify sources at this time

,  LfO Planning Project
Do not spedify design sources. You will be able to view part/package resources.

= Imported Project
Create a Vivado project from a Synplify, XST ar ISE Project File.

< Back ][ Next > Finish
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i‘ X"—l NX" Part 1: Create a new Vivado IDE Project and add RTL/DSP sources and XDC constraints

5. As shown below, click the Add Files button, select top_level.vhd , and then click OK,

then click Next

4L Add Source Files

Look in: . ril_source

@ top_levelvhd

I
b

Recent Items

Desktop

5

My Documents

LY

Computer

@

Network

File name: top_level.vhd

- POE R ARG E
Recent Directories
1 C:fugd4s-data-files/lab7 jvivado_dsp_source

File Preview

Files of type: :AJI Diesign Source Files (.vb, veo, vho, tf, elf, v, vhf, verilog, vhd, edn, svh, sv, dep, edf, vr, h, nac, vhe

6. In the Add Existing IP dialog box, click on the Add Files button, navigate to the
dsp_source folder and then select rgb2gray.mdl and click Next

4% Add Configurable IP

Look in: [ . dsp_source

» |*& rgb2gray.mdl
b
Recent Items

My Documents

iy

Computer

@
File name: rgb2gray.mdl

Metwork

2B R EOXS E
Recent Directories
= C:fug948-data-fileslab 7 fvivado_dsp_source

File Preview

File: rgb2gray. mdl

Directory:
C:ugd48-data-files/ab¥/vivado_dsp_source/dsp_source
Created: Today at 21:58 PM

Accessed: Today at 21:58 PM

Modified: Thursday 04/04/13 11:58 AM

Size: 97.2 KB

Type: MDL

Owner: XLNX mwallace

Files of type: :Conﬁgurable 1P (including DSP sub-designs) (.xco, bd, mdl, xdi, slx)
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& XILINX.

In the Add Constraints dialog box, select Add Files, and then navigate to the constraints
directory. As shown below, add the kc705.xdc file, and then click Next

-
4L Add Constraint Files [ = ]
Look in: J constraints ‘: _? ﬂ :%‘J. - ‘\3.'-* ,.3 X S '
. Y keT05xdc Recent Directories
‘;} (=) C: fug948-data-fileslab7 jvivado_dsp_sourcefconstraints -
Recent Items
File Preview
: q) A —— e -
- 24— (©) Co -
Desktop 34—
43--X
| = 5 $-—
[I 6 #-- Inc trademarks are the pr
My Documents 7 #-- respect ners
8 &
ﬂg,h-l 9 4$-- NOTICE OF DISCLAIMER: The information disclose
- 10 #-— hereunder (the "Information™) is orovided "BsS- 7
Computer < Tl | 3
N
H File name: kc705.xdc
Network : T
stwor Files of type: | Design Constraint Files (.sdc, xdc)
J

Part 1: Create a new Vivado IDE Project and add RTL/DSP sources and XDC constraints

7. Select Boards in the Project Pane and then select Kintex-7 KC705 Evaluation Platform

as shown below :

r}:lb New Project

Default Part
Choase a default Xilinx part or board for your project. This can be changed later.

c7k325tffigo00-2

Spedfy Filter
& Parts Family | Al -
[ Boards Package | All -
Speed grade | All -
Search: | Cl~
1j0 Fin Available LuT )
Board Part Count 10Bs Elements FlipFlops
-] ZedBoard Zyng Evaluatlon and Development Kit @9 xc7z020cg484-1 434 200 53200 106400
¥C7a200tthgs76-2 676 134600 269200

E_E__I

& ZYNQ-7 ZC702 Evaluation Board i xc7z020clg4a4-1 454 53200 106400

@ ZYNQ-7 ZC706 Evaluation Board i xcTz045ffg900-2 00 362 218600 437200

& virtex-7 VC707 Evaluation Platform § xcTux485tffg1761-2 1,761 700 303600 607200

< [ | =
’ < Back ][ Next > ] Finish

8. Click Next and then click Finish.
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& XILINX.

Part 2: Interacting with the DSP Module from the Vivado IDE Cockpit

The above steps setup a project. The figure below shows the hierarchy of the project in Vivado
IDE Hierarchy Browser:

Project Manager - vivado_dsp
Sources (|
A= Wt R
=& Design Sources (1)
i Ewlngd top_lewvel - structural (fop_level vhd) (1)
‘ LU rgbzgray rgb2gray (rabZgray.mdl)
EI {= Constraints (1)
= i constrs_1
----- el keT05, xde
EI 4= Simulation Su:-uru:es 1
BE-&r sim_1 (1)
=il top_level - structural (top_level vhd) (1)
5—----::: u_rgb2gray - rgb2gray (rab2aray.mdl)

M
*

Hierarchy | IF Sources | Libraries | Compile Crder

£ Spurces | ) Templates

Part 2: Interacting with the DSP Module from the
Vivado IDE Cockpit

SubPart A - Opening and Modifying a DSP Module

Open the DSP Design by double clicking on the DSP Source Module as shown below.

Project Manager - vivado_dsp

Sources O =

) A pa 13

Q= cﬁ’ _?l

- Design Sources |

== \.-h, top_| Ievel structural (top_|evel.vhd) (1)

El = Cu:unstralnts
;| B constrs_ 1

EI A Simulation Snurces
B sim_1
9--‘-\.{'}"“‘*“ top_level - structural (tof R
% u_rgb2gray - rgb2gray (rabZgray.mdl)

Hierarchy | IF Sources | Libraries | Compile Order

% Spurces | ' Templates
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i‘ X"—l NX Part 2: Interacting with the DSP Module from the Vivado IDE Cockpit

This opens the System Generator model in MATLAB/Simulink.

4] rgb2gray EEE

File Edit View Simulation Format Tools Help ‘

Grayscale conversion using the Following weights
-~ Gm&scale = 0,36R + 05045 + 01145 ) Copyright 1995-2013 Xilinx, Inc,
#-— All rights reserved.

System
Generator

ouble Click for Copyright Motice

15 19 20 21 22 2 d
red 21 g ast]
st FL
obvert.
Register
B o9snzl 32 s In »4
green 21 q a5t
e EConvert, 4 I:l
Registerl Z_1 q—m—b
38 39 40 41 42 4| In {4 AddBubl rst 8rey_output
blue 21 q ast Register3
[ BCanvert. Seape
Register? Bult
[ ones(1,23) 0] In

rst.

You can make modifications to this Simulink model if necessary. To transfer control back to
Vivado Cockpit, you must exit MATLAB.

SubPart B: Generating Sources Associated with the DSP Module

Inspect the top_level.vhd source file. This file instances the DSP module. To perform this
instantiation, you must include a component declaration (lines 92-101). The name of the
component should be the same as the name of the DSP module, as indicated below.

component rgb2gray is
port (
blue: in std_logic_vector(7 downto 0);
clk: in std_logic; -- clock period = 10.0 ns (100.0 Mhz)
green: in std_logic_vector(7 downto 0);
red: in std logic_vector(7 downto 0);
rst: in std_logic;
grey_output: out std logic_vector(31 downto 0)
):

end component;

Lines 118-126 instantiate the module:

-- System Generator Design #1
u_rgb2gray :rgb2gray

port map (

blue => blue,

clk = clk,

green => green,

red => red,

rst => rst,

grey_output => grey_output

):
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& XILINX.

Part 2: Interacting with the DSP Module from the Vivado IDE Cockpit

Click on the Generate button of the System Generator token block in the open elaborated
desogn. This action recognizes that the System Generator model has not yet been
generated, and automatically triggers generation. All files generated by the System
Generator model will now be included in the synthesis and implementation steps
automatically. You will see the MATLAB/Simulink tool that is on your path launched and the
System Generator model will be generated and elaborated as shown in the schematic below.

blue[7:01 [ u_rgb2gray
i_IBUFGDS
clk_p H 0 blue[7:0]
Ik —
cle-n IBUFDS el |
green[7:01[> green|[7:0] grey outputf31:0] ™ orey output[31:0]
red[7:O]D red(7:0]
rst[ > rst
ce rgb2gray

You can now invoke other downstream tool steps like any other RTL Sources on a Vivado IDE
design that contains a System Generator model; steps like implementation and bitstream

generation.
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!‘ X"—l NX’ Part 1: Creating a System Generator Package from Vivado HLS

Lab 8: Importing C/C++ Source Files into
System Generator by Leveraging Integration
with Vivado HLS

The System Edition of the Vivado® Design Suite, includes the feature called Vivado HLS which
has the ability to transform C/C++ design sources into RTL. System Generator has a block called
Vivado HLS located in the Control and Index libraries that enables bringing in C/C++ source
files into a System Generator model.

Part 1: Creating a System Generator Package
from Vivado HLS

1. Launch the Vivado HLS tool and open the project vivado_hls/hls_filter/hls_design
using File > Open Project as shown in the figure below:

x|
@[ tmp " his_filter "hls_designl

Location: [ l
Places Name *  Modified ||
@ arvinds 2 Launch Today

& Desktop = solutionl Today

O File System

[xgancell[ ¢ ok l
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& XILINX.

Part 1: Creating a System Generator Package from Vivado HLS

2. Inspect the contents of the file MedianFilter.cpp located underneath the sources folder
as shown in the figure below.

3. Synthesize the source file by right clicking on solution1 and selecting C synthesis >

[(5 Explorer 22

= B || [¢ MedianFilter.cpp 3

=0

R

+ 1% his_design
P w Includes
< £ Source

P 0= Test Bench

~ = solutionl
~ # constraints

< directives.tcl
o script.tcl

This file implements a 2-Dimensional median filter on 3x3 window size.

Liinclude "MedianFilter.h"
2 #define WINDOW _SIZE 3

3 typedef unsigned char PixelType;

4

5 #define PIX SWAP(a,b) { PixelType temp=|(
6 #define PIX_SORT(a,b) { if ((a)=(b)) PI»

!

8 PixelType OptMedian9(PixelType * p)

94

10 PIX_SORT(p[l], p[2]) ; PIX SORT(p[4]
11 PIX SORT(p[0], p[1l]) ; PIX SORT(p[3]
12 PIX_SORT(p[1l], p[2]) ; PIX SORT(p[4]
13 PIX SORT(p[0], p[3]) ; PIX SORT(p[5]
14 PIX_SORT(p[3], p[6]) ; PIX SORT(p[1]
15 PIX SORT(p[4]., p[7]) ; PIX_SORT(p[4]
16 PIX_SORT(p[4], pl[2]) ;

17 return(p[4]) ;

18}

19

20PixelType Mean(PixelType* buffer)
214

PixelType 1, ], min;

unsigned int sum;

£ M2 L. Z .. T

ja | D

-
£
-
2

3R BRI

Active Solution as shown below.

[+ Explorer &2
téh

= 1=£ hls_design
P mi Includes
+ £ Source
[£] MedianFilter.cpp
b iz Test Bench

= 8@ CC
< Rename

,5‘.';.‘

¥ Delete

= B || [¢ MedianFilter.cpp 2

m i Solution Settings...

10 PIX SORT(p[1], p[2]) ; PIX SORT(p[4]
PIX_SORT(p[0@], p[l]) ; PIX_SORT(p[3]
PIX SORT(p[1l], p[2]) ; PIX SORT(p[4]
PIX SORT(p[@], p[3]) ; PIX SORT(p[5]
PIX_SORT(p[3], pl6]) ; PIX_SORT(p[l]
PIX SORT(p[4], p[7]) ; PIX _SORT(p[4]
PIX SORT(p[4], pl[2]) ;
return(p[4]) ;

C synthesis > I B+ Active Solution Le* buffer)

L#include "MedianFilter.h"

2 #define WINDOW_SIZE 3

3 typedef unsigned char PixelType;

4

5 #define PIX_SWAP(a,b) { PixelType temp=(
6 #define PIX_SORT(a,b) { if ((a)=(b)}) PI»
7

8PixelType OptMedian9(PixelType * p) T
94

E= All Solutions

= Select Solutions... N;
LIII:-J.I_.'IIEI.I LITL  SUII

(o]

£ 2 A2 < .1 T

-

=8

Open Report

3
I

[+]
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& XILINX.

Part 1: Creating a System Generator Package from Vivado HLS
Once the synthesis is complete you can package the source for use in System
Generator for DSP.

4. Right click on solutionl and select Export RTL. Set Format Selection to System
Generator for DSP (Vivado) as shown in the figure below and click OK.

i) Export RTL Dialog w|
Export RTL

Format Selection

System Generator for DSP (Vivado :]

Options

[] Do not show this dialog box again.

Cancel ] [ OK
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i‘ X"—I NX” Part 2: Including a Vivado HLS created Package in a System Generator Design

Part 2: Including a Vivado HLS created Package in a

System Generator Design

1. Launch System Generator and open the file named sysgenHLSMedianFilter.mdl in
MATLAB/Simulink folder. This should open the model as shown below.

sysgenHLSMedianFilter

File Edit Yiew Simulation Format Tools Help

?

Syztem

Double click
far
more information,

¥ Copyright 1995-2013 Hilinx. Irn
#-- All rights reserved,

Generator

ouble Click for Copyright Motice

—

Noizy Image RGEZY LineBuffer

¥
=
£
=

pixel

MNoizy Input Image

Gateway Out
Gateway Outl
Gateway Out?
Gateway Out3

Gateway Outd

Scope

el

Hutputs Delayl

Filtered Image

Model-Based DSP Design using System Generatorwww.xilinx.com
UG948 (v2013.3) October 2, 2013

58

l Send Feedback l



http://www.xilinx.com/
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=ug948&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Model-Based%20DSP%20Design%20using%20System%20Generator&releaseVersion=2013.3&docPage=58

& XILINX.

2. Add a Vivado HLS block by right clicking at the center of the blue block titled “Add

Part 2: Including a Vivado HLS created Package in a System Generator Design

Vivado HLS Block Here". Select Xilinx Block Add and scroll down to the Vivado HLS

block as shown in the figure below.

& sysgenHLSMedianFilter *

SIS

File Edit Yiew Simulation Format Tools Help

&

System
Generator

Touble click
far
nore information,

¥ Copyright 1995-2013 Xilinx, In
#-- All rights reserved,

ouble Click for Copyright Motice

Moisy Image

RGB2Y

LineBuffer

pixel

MNoizy Input

--------
Gateway Out
--------

| —»

Add block

Toolbar
Up Sample
I 1 Viterbi Decoder 9.0

B vivado HLS

Scope

¥ Band-Limited White Noise
¥ Bus Creator
¥ Bus Selector

L : 1

I —pixel

Image

riltered Image

This will add a block to the model called Vivado HLS as shown in the figure below.

(=

File Edit WYiew Simulation Format Tools Help

sysgenHLSMedianFlilter *

&

System
Generat.or

Double click
for
more information,

=

Green

Blue

Noiszy Image

RGE2Y

Gateway Outd

LineBuffer

s e

Dutput Tlelayl
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& XILINX.

Part 2: Including a Vivado HLS created Package in a System Generator Design

3. Double click the block and use the Browse button to select the solution created by
Vivado HLS located underneath the hls_design directory as shown in the figure below.

|@ Vivado HLS (Xilinx High Level Synthesis)

This block allows including C.C++ and SystemC source files in
System Generator for DSP designs.

Solution]'/tmp/hls_filter/hls_design/solutionl/ I Browse

[ Use C simulation model if available

[] Display signal types

Output Sample Times | Simulink system period | =

-

[ oK H Cancel H Help H Apply l

4. Click OK on the block GUI and connect the block’s input and output ports as shown
below.

sysgenHLSMedianFilter

File Edit Wiew Simulation Format Tools Help

i Double click
far
F'.

more information,

) Copyright 1995-2013 ¥ilirx, In
#-— All rights reserved,

Syztem
Generator

ouble Click for Copyright Motice

¥

Out pixel
Inp

Moisy Input Image

SiZETrS Gateway Out

roul Gateway Outl

i pixel
row? Gateway Dut2
Gateway Dut3
row3
Moisy Image RGE2Y LineBuffer Gateway Dutd Scope
Out E_d ™ pixel
Output Telayl
Filtered Image
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i‘ X"—l NX" Part 2: Including a Vivado HLS created Package in a System Generator Design

The lab is now complete. You can interact with this block like any other System Generator blocks
and the block will participate in simulation and netlisting correctly. Successful simulation of the
design will create two images as shown below.

Noisy Input Image H Filtered Image

File Tools View 3Simulation Help

alnlon~<ol@is [  |a/s o

.[—x|p|§> IE’“IP|§’

File Tools View 3Simulation Help A

5 0@ [

Ready [:256x256  [T=131072. | Ready [:256x256  [T-131072,
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!: X"_l NXP Introduction

Lab 9: Including a System Generator Design
as a Module in an IP Integrator Design

Introduction

System Generator has a feature that allows you to export a design as an IP module into the
Vivado® IP catalog. From the IP catalog, you can then import the System Generator design as IP
into a Vivado IP integrator design. For example, you can create a data-path module in System
Generator and then add the data-path to a larger processor-centric design in IP integrator.

Using the IP Catalog as a Compilation Target

As shown below, to export a System Generator design, you need to select the compilation target
called IP Catalog from the System Generator Token:

System Generator: axi_lite

& @

Compilation Clocking General

Settings ...

| | [Kintex7 xc7K325t-3fbg676

Synthesis tool : Hardware description language :
VHDL |

Target directory :

Jnetlistaxilite Browse...

Project type :

The purpose of this compilation target is to create a Vivado IP from a System Generator design
that is accessible through all the Vivado IDE flows — an RTL-based design as well as an IP
integrator-based design. The metadata commonly referred to as VLNV (Vendor-Library-Name-
Version) can be controlled using the Settings button in the System Generator token.
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!. XIL'NX Generating Products

When you click on the Settings button, the following dialog box is displayed:

IP Packager Settings

— |IP Properties:

Vendor: pelinx Library: |system_generator |
Mame: |[xi_lite_cw Version: |L.0O

Categor‘;’:lﬁvgtem Cenarator for DSP Status: Production ""|

_|Auto Infer Interface

QK Cance| | Help |

The name of the IP is strictly derived from model name, which is the System Generator top-level
module name. To modify this name, you need to first rename the model in System Generator.
All other parameters are configurable from the dialog box. The Auto Infer Interface option is a
special control that will be discussed later in this lab exercise.

Generating Products

When you select the IP Catalog compilation target and generate the design, the following
output products are placed in the <target_directory>/ip_catalog directory:

e <design_name>.xpr : This is an example project file that instantiates the IP that is created. It
contains an RTL Testbench instantiating the IP if “Create testbench” option is turned on from
the System Generator token. It also contains an IPI block diagram with an instantiation of the
IP called <design_name>_bd.bd

e <Vendor>_<Library>_<design_name>_<Version>.zip: This is an archive of the IP created
from System Generator. If you want to use this IP in another project or design, you must
follow the instructions provided in the compilation waitbox as shown below.
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i. X"_l NX, IP Creation Modes

Compilation status

—————————————— Instructions on how to use this IP---—————-—————-
1. Copy xilinx_system_generator_axi_lite_wl_0.zip to wour project Tocation.
2. In wour Vivado project, click on "IP Catalog". 1In the IP Catalog window, right cli
Ick on any empty area, select "IP Settings...".
3. In the pop up dialog, press on "Add Repository..." button from "Repository Repositor
v Manager" and provide the path to wour IP location.
4. Press "Add IP..." button and provide wour IP File, then click on 0OK.
5. Find wour IP category from IP Catalog, wour IP will he under this category. Doubhle ©
Tick to add this IF to wour project.
. Under Design Sources of wour project, wou will find a new IF added in. Use that IF n
ame in your code to finish your design. |
INFO: [Common 17-206] Exiting “Vivado at Wed May 8 17:53:48 2013... ]
Hide Details
IP Creation Modes
There are two IP creation modes in System Generator and a combination of these modes is
supported as well.
e Port/Pin Interface Packaging
e Port-Name-Based Interface Inference
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i. X"_l Nxv Port/Pin Interface Packaging

Port/Pin Interface Packaging

In this mode, the Gateway In and Gateway Out blocks are packaged as Simple RTL Ports.

Do the following:

Invoke System Generator, navigate to the lab9 design data folder and open the file named
raw_interfaces.slx.

raw_interface *

File Edit WView Display Diagram Simulation Analysis Code Tools Help
M — " =
k- 8 =ReM=IR'RCH 2 O » (Y~

raw_interface

® raw_interface

| ﬂ
* In

E3 W

Sina Wave data_signal
= Systam b

Ganaraiar +-h—h
B rst
rasult
0 » IE'_ Accumul ator
Scope

Canstant rel
B
Ready [100% ode4s|

Double-click on the System Generator token and verify that the IP Catalog compilation target is
selected.

Verify that the Create testbench option is checked.
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i. X"_l Nxv Port/Pin Interface Packaging

Click on the Settings button and configure the IP Packager Settings as shown in the following
figure.

IP Packager S5ettings

— IP Properties:

Vendor: |User Company Library: [SysGen
Mame: raw _interface_cw Version: |L.0

Category:[System Generator for DSP | Status:  Production =

_|Auto Infer Interface

Ok Cancel | Help |

Click OK, then click Generate on the System Generator token.
The generation process creates output products in the following directory :

a. <target_directory>/ip_catalog/User_Company_SysGen_raw_interface_v1_0
contains the files representing the System Generator design as a packaged IP

b. <target_directory>/ip_catalog/raw_interfaces.xpr is an example project that
contains an RTL Simulation design example and an IP integrator design file
instantiating the block/ip as shown in the figure below :

= Design Sources (2
wh raw_interface_bd_wrapper - STRUCTURE (raw_interface_bd_wrap
¢—J{'¢ raw_interface_bd_i - raw_interface_bd (raw_interface_bo bd) (1)
<E>—.Ln raw_interface_bid - STEUCTURE (raw_interface_bad wvhd) (1)
|—d_.} raw_interface_1 - raw_interface_bd_raw_interface_1_0 iraw
i:&- User_Company_SysCen_raw_interface_v1_0_0 (User_Company_SysCen
= IP=XACT (1)

g.—u Caonstraints (1) h

= Simulation Sources (1)
cim 1 (0
¢_Tp—.ﬂn,*, raw_interface_tb - STRUCTURAL (raw_interface_th.vhd) (5)|
whi cll_drivier - ®lclk - behavior (raw_interface_th vhd)
whi data_signal_driver - xltbhsource - behavior (raw_interface_thou
whi result_load - xitbsink - behavior (raw_interface_thowhd)
ahi rst_driver - xltbsource - behavior (raw_interface_thovhd)
- sysgen dut - User Company SysGen raw interface w1 _0_0 l[

Select Behavioral simulation to verify the IP functionality in an RTL simulation
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i. XIL'NX, Port-Name Group-Based Interface Inference

Double click on the IP integrator icon to open the design with System Generator IP instanced in
it as shown in the figure below.

raw_interface_1

clk[———clk
rst[_————rst zresult[lszo] -—Dresult[lS:O]
data_signal[15:0] [>———=data_signal[15:0] = =

raw_interface

Run a validation check on this design to confirm the IP works within IP integrator

Port-Name Group-Based Interface Inference

In the IP Packager Settings dialog box, shown below, the Auto Infer Interface option infers
two different interfaces based on a standard naming convention..

IP Packager Settings

— IP Properties:

Vendor: |User Company Library: [SysGen
Mame: [fgain_control_cw Version: |1.0
Category:System Cenerator for DSP | Status:  Preduction '|

R Auto Infer Interface

QK Cancel | Help |

The naming conventions are enumerated in the table below. The strings displayed are suffixes.
For each interface the prefix must be the same.

Interface Name Gateway In (Restriction) Gateway Out (Restriction)
AXl4-Lite Slave awaddr awready (1 Bit Wide)
awvalid(1 Bit)
wdata wready (1 Bit Wide)
wvalid(1 Bit)
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& XILINX.

Port-Name Group-Based Interface Inference

bready(1 Bit)

bresp (2 Bits Wide)

bvalid
AXl4-Stream Slave tdata tready
tvalid(1 Bit)
AXl4-Stream Master tready(1 Bit) tdata
tvalid(1 Bit)
Reset (full name) aresetn
Clock clk

Compiling the gain_control Design

Navigate to the lab9 folder and open the System Generator design named gain_control.slx. A
gain block is implemented using a multiplier with one input controlled using an AXI Lite
interface and the other input is part of the data path as shown in the figure below.

=- [ gain_control
AX| Transaction Ger
AXlLiteinterface

[‘I [Ilz] «

gain_control

| FEle Edit View Display Diagram Simulation Analysis Code Tools Help
B <«

Model Browser

®

B e

B85 4O P = @[z " @
gain_control  » | AXiLitelnterface
["a] gain_control » 'l
I ]
o z
Sina Wals data_in b
data_out
Mult Seapat
i:
—
S
Systan ) H

value_to_:

AXILtalntarface

proc_out = proc_in

AX| Transaction
Ganaraor

|[ prac_in

Ready

[100%

ode45|

Underneath the AXILitelnterface subsystem is an MCode block that models a single AXI
Lite Interface. The MCode block is attached to Gateway In and Gateway Out blocks, as
shown in the figure below.
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& XILINX.

Port-Name Group-Based Interface Inference

& axi_awwvalid
<signalz>
& _axi_awaddr
5_awi_wvalid

<aignalds
s_axi_wdata

=

proc_in

<signalSx
5_axi_braady

&_axi_arvalid

&_axi_araddr

& _awi_maady

<signalgs
arasain

m

n
m >
n

wvalid

wdata

bready

arvalid

araddr

rready

awvalid

awaddr

aresetn

AXILiteSlaveRegisterFull

value

aweats o[ our}—»
o ——*__out]

&_axi_awraady

weas| o[ our}—»
o —L_out]

£_axi_wraady

bvalid————»[  out |—»
— [ out]

& axi bvalid

[ ou}—»
brespl > _out]

& awi_brasp

arready 4b-

5_axi_arsady

S axi_rvalid

rdata 4I~

MCode

& axi_rdata

proc_aut

As you can see, all gateway's belonging to a single slave AXI-Lite interface have a

common “s_axi” prefix.

Compile this design using IP Catalog target with the Auto Infer Interface settings checked. On
compilation, the following example IP integrator design is created.

clk_wiz_1
cu Nl o || EElS T ] c-\_oJ'.lL
reset_rtl [ J( ‘

mdm_1

microblaze 1

|[[mremmeT

MEDEEUC_O
Debiug 5V5_Rst

proc_sys_reser 1

i

DLMEdh

Microsiaze |

microblaze_1_kocal_memary

_gpne_cik
_resetin

mh

=aux_reset in peripheral_reset}0-0) pm

Bus_Sruct reset 1 fa—

o
I |[muse
1= L {
& b 1 h i =
microblaze_1_axi_periph
i)
7]
_Ax
et
Thio-0)

L——mi detnig_sys_rst * aresetni 1

——=jdem _bocked peripheral aresenid 1)

cal.:_leS.DZD—I

_ARESETMI 00} I i
_ACLE u A
_ARBSETHET D)

aresetn

Model-Based DSP Design using System Generatorwww.xilinx.com

UG948 (v2013.3) October 2, 2013

l Send Feedback I

69


http://www.xilinx.com/
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=ug948&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Model-Based%20DSP%20Design%20using%20System%20Generator&releaseVersion=2013.3&docPage=69

& XILINX.

Port-Name Group-Based Interface Inference

Select Validate Check to ensure that the design created is a topologically legal one.

clk_wiz_1

CLE_IN1_D [ | e 01 K_INL D clk_cuitl
ocked

reset_rtl i o
CIOCRI NG WIZare

Validate Design

o;’ Walidation successful. There are no errars or critical warnings in this design. |

=

| | | —|.Bun_|'\e!l._i'| p-eripher.u_mcun:ml- |

Verifying the gain_control Design

To verify that the design works, you need to write some software. The first step to writing
software is to export this design to the software Development Kit (SDK).

Also in the Address editor Pane, you should verify that the right address range is allocated to
the System Generator AXI lite interface. As you can see, 4K address space is reserved because
while exporting from System Generator awaddr and araddr are 12 bits wide.

Ze Diagram X [ Address Editor X
Q, | Cell | Base Mame | Offset Address | Range | High Address
= |§-4F /microblaze_1
"f’ B Data
= m fmicroblaze_1_local_memaory/dimb_... Mem 0x00000000 218 = 0x0000LFFF
e = fgain_control_1 regQ 0x44400000 4k = 0x44A00FFF
E Instruction
L en /microblaze_1_local_memoryfilmb_b... Mem 0x00000000 Bl = 0x00001FFF
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& XILINX.

Port-Name Group-Based Interface Inference

Right click on the IP integrator design and select Export Hardware to SDK as shown in the
following figure and ensure that SDK is launched.

-
“hig gain_control_b

(E)—.f#. goin cantral i
iy

5 Design Sources (3} J

& Source Mode Properties. .. Ctr
. Use * Open File Al
1IP=X Create HDL Wrapper
| Constra ) -
) ) Wiew Instantiation Template
o Simulati
# -, <im Generate Qutput Products. ..
il Feset Output Products. .
il g Export Harchware for SDKE. ..
-‘-‘:'T' A FELRAYE BIOCK CIesigh.. .
wh H

In SDK, you need to create a default Application project for the given exported hardware.
This creates a test application for all peripherals In this case, the only major peripheral is
the System Generator IP.

Open the xparameters.h file included in the Peripheral Test application and you will see the
following lines:

/* Definitions for periJ,:-heral GAIN_CONTROL_1 #*/
#define XPAR GAIN CONTROL 1 BASEADDR 0x44A00000
#define XPAR_GAIN CONTROL 1 HIGHADDR 0Ox44A00FFF

This can be co-related with the address map in the IP integrator design environment and
is essentially the software interface to the System Generator peripheral.

Modify the Test Peripheral application as shown in the following figure.

#include <stdio.h=

#include "xparameters.h"
#include "xil cache "
#include "xil _io.h" |

int main()

{

X1l_ICacheEnable();
X1l DCacheEnable();

int 1;
for (i =0: i -1; i++) {
Xil_Out32(XPAR_GAIN_CONTROL 1 BASEADDR,1);

I

X1l DCacheDisable();
Xil_ICacheDisable(};

return 0;

Save and exit. This creates an ELF file executable.
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& XILINX.

Port-Name Group-Based Interface Inference

Locate the ELF file and associate as shown in the previous two figures. The ELF file should be
located underneath gain_control.sdk/SDK/SDK_Export/test/Debug/*.elf.

U SITTILELIOTT S0UrLeEs L)
&G sim_1(24)

@il gain_control_bd_wrapper - STRUCTURE (0ain

&, gain_control_bd_

smie smmtesl el fasmie s st

Top modul

Synthesis

&~gh gain_control_
@@=l gain_control_th - 5T
il FPCA_Express_work,
ahi FPGA_Express_worlk

@=— Data Files (15)

@= ELF (2}
‘I J
Hierarchy IF Sources Libraries
ib Sources 7 Templates
Properties

« +[B[E]

& gain_control_bd.bd

& Source Mode Properties. ..
* Open File
Create HOL Wrapper
Wiew [nstantiation Template
Cenerate Qutput Products. ..
Feaset Cutput Products. ..
Export Hardware for SDR. ..
Package Elack Design...

Feplace File...
@® Copy File Into Project
Copy All Files Into Project
H Remowe File from Project. .
Enable File
Disakle File
Hierarchy Update
@ Refresh Hierarchy
e St as Top
Set As Out-Of-Context Module.
Set File Type...
Set Uszed In...
Edit Constraints sets...
Edit Simulation Sets

Ctri+E
Ahl+0

Alt+
Delete
Alt+Equals
Alt+hinus

Location: Swvrlefhd
Type: @
Part: HOTkZ25
Size: 44.2 KB
Modified: Today at
Copied 1o gain_con
Fead-onky o

1] l
General Froperties

Tl Console

E| “run 50000ns

PNnataer R1nck Mamnrme Ga

Associate ELF Files. ..

1 Add Sources. ..
Co To Source

Alt+A
F7

Associate ELF Files

ELF File Aszzociations

| Associate an ELF file with a processor instance (Address Map). ELF files are
" awailable after running generate on your embedded desigh sources.

Processors/Address Maps

iz Design S0urces
* @ & gain_control_be_i
L& microblaze_1
&7 3imulation Sources
(‘;P-l.-“- sirm_1
@ gain_control_bd_i
L& microblaze_1

| Azsociated ELF File
test.elf L]
tast elf

| ok || cancel
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& XILINX.

Port-Name Group-Based Interface Inference

Launch behavioral simulation. This action compiles all the sources including the System
Generator Peripheral. The Code is now setup to provide Gain values that increment by 1. To
observe this, you will reset the system, set up the clock and feed 1 to the data_in port by
executing the following Tcl commands on the XSIM Tcl console :

add_force reset_rtl {1 Ons} {0 100ns}

#Setup Clock

add_force CLK _IN1 D clk n {1 Ons} {0 5ns} -repeat _every 10ns
add_force CLK _IN1 D clk p {0 Ons} {1 5ns} -repeat _every 10ns
#Set Data In to 1

add_force data_in {0 Ons} {1 100ns}
run 50000 ns

On the waveform viewer you should see data_out incrementing with time.

End of Lab
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& XILINX.

Introduction

Lab 10: AXl4-Lite Interface Synthesis

Introduction

In this lab, you will learn how to package a System Generator design with a synthesized AXI4-

Lite interface such that a processor can control the value of registers within the interface ports.

Requirements

In order to complete this lab, you must have the following tools installed:
1. Vivado Design Suite System Edition with SDK (v2013.3 or greater)

2. MicroZed Hardware Board or any other Xilinx supported Board

Note: You can verify that the SDK tool is installed by navigating to the Xilinx installation

directory and observing the SDK folder.

= | = 28
@vv| <« Local.. » Kilinx » - |¢'u’. | [ search Xitinx 0|
Organize ~ Include in library « B== - E:l ':9:'
=
- Favorites Name .
Bl Desktop DocNav
4 Downloads
| Recent Places Vivado
Vivado_HLS
- Libraries a e - b .

If the SDK folder is not present, download the file named Vivado 2013.3: Standalone
SDK Single File Download Image from the Xilinx.com Download area and install the

file.
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& XILINX.

Procedure

Procedure

1. Invoke System Generator for DSP from the Windows Start menu, navigate to the Lab 10
folder, and then open the rgb2gray.slx model in Simulink. The model is shown below:

#3, rgb2gray * [E=REER>
File Edit View Display Diagram Simulation Analysis Code Tools Help
jeifw] = > )
-8 & e ECOP 2 @2 bomd -] @~
rgb2gray
@ |[Pa|rgb2gray -
@ _ I
“5y= cale conversian Lsing the fallowing waights
IE' Grayscale = 18 + 66/256°R + 123‘25B‘G+25'2$“B|
Systam
= Gener atar
,:} —
1 *| In »  x65
Constant Red =
RMut £
AddSub
1 *| In » =129
Green -
Constantt
. 2 -
Ghiut k.| sinterpre -_>
u e ——F
\\ AddSub2 Reinterpret Comert Scape
1 *| In >
| S L— -
Corstant2 Blue
Bhult Constant2
>
Ready 100% VariableStepDiscrete

2. Simulate the model to ensure that the results are correct. In this case, the output should
be 17.

3. Do the following to map each Gateway In block to an AXI4-Lite Slave Interface so it can
be controlled by a Micro Processor:

a. Open (double-click on) the Gateway In block named Red.

b. Select the Implementation tab.

c. As shown below, set the control called Interface to AXI4-Lite.

Gateway in block. Converts inputs of type Simulink integer, single,
double and fixed-paint to Xilinx fixed-point or floating-point data
type.

Hardware notes: In hardware these blocks become top level input
ports.

Basic Implementation |

Interface Options

Interface | AXI4Hlite -

Auto assign address offset

Address offset | hex2dec(007)

Description ‘Red'

Model-Based DSP Design using System Generatorwww.xilinx.com 75

UG948 (v2013.3) October 2, 2013
| Send Feedback l



http://www.xilinx.com/
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=ug948&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Model-Based%20DSP%20Design%20using%20System%20Generator&releaseVersion=2013.3&docPage=75

!: X"_l NXP Procedure

Note: It is important to provide a "“meaningful” name to the Gateway In block, in this
case "Red” because it will be used in the Software Driver Generation, as you will see later.

Repeat the process for the Gateway In blocks named Green and Blue, and the Gateway
Out block named Y.

You are now ready to package the design. Double-click on the System Generator token
and note that the Compilation Target is set to IP Catalog. Additionally, for this lab, the
device is set to ZynQ, the same device located on the MicroZed board.

Change the target directory to ./netlist_mzed, and click the Generate button on the
System Generator token. This action packages the System Generator design as an IP
module in the sub-directory called “./netlist_mzed/ip”. In addition, an example Vivado
IDE project file named rgb2gray.xpr is created and configured to the MicroZed board.

Note: The board is inferred from the part settings on the System Generator token
located at ./netlist_mzed/ip_catalog/rgb2gray.xpr

Double click on the project file rgb2gray.xpr to open the Vivado IDE project. The
sources pane will look like the figure below.

Sources — 0O & =
A==/ 28 B
(=5 Design Sources (2]
: E} i«fi % rgb2gray_bd_wrapper - STRUCTURE (rabZoray_bd_wrapps
: EI Ja. "gb2gray_bd_i - rgb2gray_bd {rgbZ{.rav_bd bdltl}
: gt rgb2gray_bd - STRUCTURE (rab2gray_bd.vhd) (4]
. [#-@h rgb2gray_stub - STRUCTURAL | ’u._w—._e'_'“:-:.'.'-*:: (1)
(-5 Constraints
[+ Simulation Sources (2]

4 | 1 r 0

Hierarchy | IP Sources | Libraries | Compile Order
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f: XI LI NX. Procedure

8. Double click on the rgb2gray_bd_i Block Design instance to open the IP integrator
Block Diagram, as shown below:

J:—“m X]ﬂkktessﬂiln X] O w”» %

a
o

C R QP PRD 7|2

9. As shown in the figure below, move to the Flow Navigator and select IP Integrator >
Generator Block Design:

Flow Mavigator « Block Design - rgb2gray_bd

za T
ey — ]
) az= et BE
4 Project Manager =
i 3 (-5 Design Sources (2)
4 Project Settings . B+, rgb2gray_bd_wrapper - STRUCTURE {rcb2aray_bd_wrap|
5% Add Sources [N =% "N b 2oray_bd_i - rgb2gray_bd (rgb2gray_bd.bd) (1)
[#-&h rabZaray_bd - STRUCTURE (rabZaray_bd.vhd) (4)
LF 1P catalog . G-@ rgb2gray_stub - STRUCTURAL (rgb2gray_mod.vhd) (1) =
-3 C ints l§
4 PIntegrator | ||| @45 Simulation Sources (2) W
45 Create Block Design
5% Open Block Design Iy
&2 Generate Block Design F
R | — P O o3
4 Simulation IP Sources | Libraries | Compile Order | =
4#% simulation Settings WHDMMEmv] e

Click the Generate button on the pop-up dialog box.
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& XILINX.

10. Click on Generate Bitstream in the Flow Navigator.

Procedure

4 Implementation
Design Runs
ﬁ Implementation Settings a
M,
[ Run Implementation ame
_ o, |El-er synth_t
[ ‘ Open Implemented Design -~ b impl 1
=]
4 Program and Debug E}S
e BIS I eam Seting H
o] Generate Bitstream "3
~ L
b g® Ot E Enager #
B Launch iMPacT =k
| P —
5 Td Console | (& Mess

Generate a programming file after implementation

11. As shown below, bring the Vivado IDE Sources pane to the front, right click on the
rgb2gray_bd_i Block Design instance and select Export Hardware to SDK.

Block Design - rab2gray_bd

Sources

M
A

3= Diagram x

<

D\E%|rj8ﬁ|. *#[]| i rab2gray_bd »
=& Design Sources (2] 'D_Q‘
i [2iligl rgb2gray_bd_wrapper - STRUCTURE (robZaray_bd_wrap a4
N =" Brob2agray_bd i - rabZgray_bd (rgb!pgp -
[} rab2gray_bd - STRUCTURE (1 % Source Mode Properties... Ctrl+E
: [-@ rgb2gray_stub - STRUCTURAL (rab2or| 2 Open File Alt+0 fere
-1 Constraints
G- Simulation Sources (2) Create HDL Wrapper... s
View Instantiation Template w::
Generate Qutput Products... perpl
Reset Output Products... fsRe
m Export Hardware for SDK... % syt
IP Sources | Libraries | Compile Ord Package Block Design...
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& XILINX.

Procedure

12. As shown below, select the Launch SDK option on the pop-up dialog box, then click OK.

i~

ﬁl"' Export Hardware for 50K

=

| Export hardware platform for SDK,

Options

Source: &, rab2aray_bd.bd
Export to: | 0 <Local to Project=
Workspace: | & <Local to Project:

Export Hardware

[0

Indude bitstream (Mote: an implemented design must be loaded)

Ok, H Cancel ]

-

Next, you are going to add the rgb2gray_bd IP to SDK, so SDK can find the appropriate

drivers.

13. As shown below in the SDK GUJ, select Xilinx Tools > Repositories and add <full path
to the directory containing the System Generator Model (.../netlist_mzed/ip) to the local

repositories in SDK.

File Edit Source Refactor Mavigate Search Run  Project | Xilinx Tools | Window Help

2
- - -
i %

|

=8
SR-3.0

[T Project Explorer &3

4 g hw_platform_0
=| example_dds_bd_wrapper.bit
psi_init.c
ps?_init.h
@ psT_init.html
|=] psT_init.tcl
@ ps7_summary.html
|3 system.xml

&~ ai - ¢ W

Generate linker script

ckage Settings
@ Repositories
| IF system.xml

hw_platform_ §

Design Informatia E

Target FPGA Devid [3]
Created Wil
Created ﬁ

Address Map for p <
psl_a E

Program FPGA
Durmp/Restore Data File
Program Flash

AMD Console

Launch Shell

Configure ITAG Settings

System Generator Co-Debug Settings
Create Zynq Boot Image

14. Create a new Application Peripheral Tests Project by selecting File>New>Application

Project.
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& XILINX.

Procedure

15. Name the application testsysgen as shown in the figure below and click Next.

r
Mew Project =

Application Project

Create a managed make application project.

Project name: testsysgen

Use default location

Chsb\netlist_mzed\ip_cataloghrgb2gray.sdk\SDK\SDK_Expor Browse...

default

Target Hardware

= =]

1

Hardware Platform [ hw_platform_0

Processor [ps?_cortexaQ_U ']
Target Software

05 Platform Istanda\one V]
Language @C @ Cesr

Board Support Package @ Create Mew  testsysgen bsp

(@) Use existing | testRgb_bsp

@ < Back Net> | [ Fimsh | |

Cancel

16. Select Peripheral Tests as shown below and then click Finish.

MNew Project

Templates

Create one of the available templates to generate a fully-functioning
application project.

Available Templates:

IwIP Echo Server
Memory Tests

D
Zyng FSBL

o e s

[,

Dhrystene Simple test routines for all peripherals in- »
Empty Application the hardware,
Hello World

@ Next » Finish | |

Cancel
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!: X"_l NXP Procedure

17. Modify the test program to exercise the System Generator Peripheral as shown below:

Include the driver header file. This is derived from the top-level name of the RTL created
from System Generator for DSP design. This should be similar to the name of the
Simulink model with lower case characters as well as some mangling to ensure the name
does not conflict with a reserved VHDL or Verilog words.

#include "rgb2gray.h”

In the main() code, add the following lines to help with modifying frequency :

{
/*
* Writing to Red Blue and Green Ports
*/
rgb2gray Instance;
rgb2gray_Initialize(&lInstance, XPAR_RGB2GRAY_O_DEVICE_ID);
rgb2gray red write(&lnstance, 1);
rgb2gray blue write(&Instance, 1);
rgb2gray green write(&lnstance, 1);
/*
* Writing to Red Blue and Green Ports
*/
ug y;
y = rgb2gray y read(&Instance);
rgb2gray_ red_write(&lnstance, 2);
rgb2gray blue write(&Instance, 2);
rgb2gray_green_write(&lnstance, 2);

}

XPAR_RGB2GRAY_@_DEVICE_ID is defined in xparameters.h that was used to create the
board support package.

[ Project Explorer 12 = B[ [ testperiph.c &3 = B[ 5% outline 2 @ MakeTarge| — 8
=] <‘|='=(>| T~ #include "xqspip;.h" & %8s o 7
. [ hw_platform 0 E #include "gspips_header.h™ - ;
- - — #include "xdevcfg.h”
s I I
FR= tﬁ:tR_gb . #include “devcfg_header.h” = xparameters.h
> Binaries #include "wscutimer.h” & wl_cacheh
> [ Includes #include "scutimer_header.h” ®  xscugich
+ = Debug #include "wscuwdt.h” 2 xil_exception.h
4 (= sre #include "scuwdt_header.h™ B scugic_headerh
#include "rgb2 h" - '
. [n] devcfg_header.h inciude rebegray 2 xdmaps.h
. [ dmaps_header.h = int main() =l dmaps_header.h

- [B] ermacps_header.h
- B gspips_header.h
. [h] scugic_header.h

=l xemacps.h
= xemacps_example.h
static XScuGic intc; =

. emacps_header.h
static XEmacPs ps7_etherne|_

[0 scutimer_headerh static XScuTimer ps7_scutdy o xqulJips.h

> [ scuwdt_headerh static XSculWdt ps7_scuwdt i d qgspips_headerh
o [ testperiph.c U xdevcfg.h

o [ xdevcfg_selftest_example.c )(:i.l_ICacheEnable(); ®l  devcfg_header.h
+ [ xdmaps_example_w_intr.c )F}_l—DCEChEEnablEO" W = xscutimer.h

> @ xemacps_example_intr_dmal N :“”.-."iting to Red Blue and 1 = scutimer_header.h
*/ o xscuwdth
rgb2gray Instance; k-
rgb2gray_Initialize(&Insta U rgb2gray.h
rgb2gray_red write(&Instam
rgb2gray_blue_write(&Insta .

- ] xemacps_example_util.c
- B xemacps_sxample.h
o [€] xqspips_selftest_example.c

2 [€] xscugic_tapp_example.c ® main():int

o €] xscutimer_intr_sxample.c
4| i 3

. [ wscutimer polled example.c
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& XILINX.

Procedure

18. Setup SDK for Debug. In the Project Explorer, right click on testsysgen and select Debug
As>Debug Configurations.

Show in Remote Systems view ®  scutimer_heac

ing toe Red Blue and 1

Convert To.. o xscuwdth
Run As O A v o Seheade
Debug As 3 GD:B 1 Launch on Hardware (GDE)

Profile As 2 -|§|::F 2 Launch on Hardware (System Debugger)

Team » [[€] 3 Llocal C/C++ Application

Compare With 4 i: 4 Remote ARM Linux Application

Restore f Local History... . .
Fstore from Local History Debug Configurations...
A Run CIC L Cads Anaberic

Model-Based DSP Design using System Generatorwww.xilinx.com 82

UG948 (v2013.3) October 2, 2013
| Send Feedback I



http://www.xilinx.com/
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=ug948&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Model-Based%20DSP%20Design%20using%20System%20Generator&releaseVersion=2013.3&docPage=82

i: XIL'NXP Conclusion

19. As shown below, select Reset entire system and Program FPGA as shown below.

Mame: System Debugger Local Host testRgb.elf

>

#. Target Setup . §7 Application | #9= Arguments| B Environment| 55 Symbol Files| &2 Source| ™2

Debug Type: [Standalone Application Debug VI

Hardware platferm: | hw_platferm 0 -
Bitstream file: rgb2gray_bd_wrapper.bit

Initialization file  ps7_init.tcl

Summary of operations to be performed

Reset entire system
Program FPGA

Following operations will be performed before launching the debugger. -
1. Reset entire system.

2. Program FPGA fabric (PL).

Run ps7_init 3. Run ps7_init.

. 4. Run ps7_post_config.
Run ps/_post_config 5. All processors in the systern will be suspended, and Applications will be
downloaded to the following processors as specified in the Applications
tab.

1) ps7_cortexad 0

Select Debug. This should launch the Debugger and allow you to step through the code. Verify
that the value of Luminance is 17 and then 18.

Conclusion

A System Generator design can be packaged to include an auto-generated AXI4-Lite interface at
the ports.
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